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Abstract

Characterization of brain signals using the electroencephalogram during the
stroop test

Shivangi Sanjay Dande

The study of mental stress is essential to elevate our understanding of the

designer's cognitive approach during a creative design process. As the first step in this

effort, this thesis focuses on the analysis of the electroencephalogram (EEG) signals of

the subject during the stroop test. Computer based stroop test, consisting of six difficulty

levels, was developed and used as a stressor. The EEG data was recorded on Fz, Cz, Pz

and Oz channel locations. Average absolute power of alpha, beta, delta and theta bands at

all the channel locations was calculated. The subject's average performance on the Stroop

test was calculated based on his/her reaction time and incorrectness.

It was observed that the power of theta band is more dominant in the Fz channel.

Since the theta band corresponds to the subject's mental/emotional stress, the present

study suggests using the theta band in Fz location for further analysis during the design

process. It was also observed that Alpha and beta powers, corresponding to the subject's

vision, are more dominant in the Oz channel. A simultaneous comparison of the

performances and of the theta power of different subjects suggested a direct relationship

between the performance and the theta power. The present study demonstrates the

potential use of theta power, after being quantified in terms of mental/emotional stress, in

obtaining a correlation between the subject's performance and mental/emotional stress.
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The present thesis laid a foundation for on-going analysis of designer's mental

stresses during design related tasks, in Dr. Zeng's research group.
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1. Introduction

Mental/emotional stress is a normal physical response to both internal and

external events that make people feel fatigued or threatened. Mental/emotional stress

affects every-day human life and it also affects human work performance. After a certain

point, it may also cause major damage to the nervous system and may severely affect a

person's productivity in work and his/her quality of life. The cognitive signs and

symptoms of the stress are memory problems, inability to concentrate, poor judgment,

negative thinking, constant worrying, to name a few.

1.1 Purpose and Motivation

The study of mental/emotional stress is of great importance in design. Design is

nothing but a logical and sequential process intended to solve a problem. Various design

methodologies have been suggested to assist designers in generating quality designs in an

effective and timely fashion. It is very important for every designer to develop a good,

structured and logical design methodology. According to the Yerkes-Dodson law, there

exists an inverted U-shaped curve that correlates a designer's performance and

mental/emotional stress during the design task, as shown in Figure 1 [I]. It can be

observed that the best performance is achieved at an optimal stress level for a given task

and the performance goes down in low or high level of arousal. Hence a good design

methodology should aim to keep the designer's stress in the optimal range of stress [2-5],

so as to achieve the best performance. Developing such a design methodology is crucially

and primarily dependant on the quantification of the designer's metal/emotional stress

and on modeling the relationship between the designer's stress and performance.
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Figure 1: Stress Vs Performance, according to the Yerkes-Dodson law [I].

The physiological measurement of workload, stress or fatigue is an outcome of

the central nervous system. Though it is not possible to measure mental activities directly,

they can be detected through neural responses. The autonomic nervous system in the

human body is a closed-loop automatic control system, which balances action and re-

action processes within the body, as shown in Figure 2. Mental/emotional stress causes

disturbances in the equilibrium of this control system. An elevated and prolonged stress

level is a silent killer and cannot be noticed without the help of advance

neurophysiological monitoring tools.

The stress can be assessed or quantified by the measurement of the physiological

variables. These physiological variables can be broadly classified into the following three

categories: [6]

1 ) Brain-related activity
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2) Eye-related activity

3) Heart rate variability

The present thesis is focused on only one physiological variable, i.e. the brain related

activity. The following sub-section introduces some of the measurable physiological

variables (electric signals) related to brain and their measurement technique. The

necessary details of the anatomy of human brain and its functioning are also provided.

Centra) and peripheral
nervous systems

ZHS (brain and
spinal cordi

lii^SSill, PNS !motor andmJBamj r^SiSH/ s6!1S0ry nerves)
Ka tiillHIU

'JjM

Autonomic nervous system
O— Parasympathetic nerves
G>·~ Sv*v,mth*?àc serves M

*-.*%.

Figure 2: Autonomic nervous system [7].

1.2 Human Brain and Electroencephalogram (EEG)

The anatomy of human brain is shown in Figure 3. Medulla Oblongata and

cerebellum consist of the posterior part of the brain and the cerebrum consists of the



anterior and frontal part. The cerebrum consists of four lobes, viz. frontal, parietal,

temporal and occipital. The locations (cf. Figure 3) and functions of these four different

lobes in human brain are as follows [8]:

• Frontal lobe: The frontal lobe is located in front of the parietal lobe and above and

anterior to the temporal lobe. The functions associated with the frontal lobe are

planning, problem solving and emotions.

• Parietal lobe: It is located above the occipital lobe and behind the frontal lobe.

The functions associated with this lobe are recognition, perception of stimuli and

movement.

• Temporal lobe: It is located beneath the Sylvain fissure on both left and right side

of the hemisphere. The functioning of occipital lobe is related to memory,

recognition of stimuli and speech.

• Occipital lobe: The occipital lobe mainly contains visual cortex. Its functioning is

associated with visual processing.
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Figure 3: Anatomy of human brain [9].

The recording of brain's electrical activity by placing electrodes over the scalp is

called as Electroencephalography, and the equipment used to do electroencephalography

is called as electroencephalogram (EEG). The nerve cells in the brain, often called as

neurons, are responsible for the electrical activity. EEG can be used to measure the

changes in the neural electrical activity, which can be caused due to changes in the

overall mental state or due to excessive workload or mental fatigue. In EEG, the electrical

signal is recorded as a time-varying difference between one scalp electrode and one

reference electrode placed on the scalp or earlobe or anywhere on the body. The electrical

activity of the brain can simultaneously be measured at different positions of the brain

using many electrodes. These electrodes are placed over the frontal, the parietal, the

occipital and the temporal lobes of the brain.
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Figure 4: Structure of a single neuron [10].

As mentioned before, electrical activity in the brain is produced by the neuron,

which is a very important part of the nervous system. Neuron, as shown in Figure 4, is an

excitable cell in the brain which transmits an electrochemical signal. Neurons are able to

send such signals for long distances and can pass messages, through these signals, to

other neurons. Neurons are the most basic functional and structural units of nervous

system. A neuron contains three main parts:

1) Cell body - the cell body contain nucleus and cell bodies of neurons vary in size.

2) Dendrites - are small-diameter, short extensions of protoplasm of the perikaryon.

3) Axon - is a protoplasmic continuation of the perikaryon. Axon diameters range

from 1 or 2 micrometer up to 1 6 or 1 8 micrometer.

An electrical impulse, generated in the cell body, goes down from the axon to the

synaptic terminal. There is a small gap between two neurons, combined with the endings

is called Synapse. A synapse consists of 3 parts.

1) Presynaptic ending



2) Postsynaptic ending

3) Synaptic cleft

The synaptic vesicles contain neurotransmitter which fuses with the presynaptic

membrane and allows the release of neurotransmitters into the gap. The neurotransmitters

diffuse across the synaptic cleft where they can bind with the receptor sites on the

postsynaptic ending. Once neurotransmitters are attached to postsynaptic receptors, they

allow signals to continue through the next neuron and are called excitatory or they stop

them and are then called inhibitory. In this way the electric potential is generated and is

transferred to other neuron [8, H]. It has to be noted that the EEG signal recorded from

the scalp reflects the post-synaptic potential rather than the action potential. It is

practically impossible get the potential from one neuron and EEG recorded signal is from

a large neuron population.

When electrodes are attached on scalp locations (on different lobes), the potential

in millions of neurons is changing synchronously and this will create various types of

rhythms. There are four major different types of frequencies that are generated and are

shown in Figure 5.

• Delta (0 to 3 Hz): Delta waves lie within the range of 0 to 3 Hz, with variable

amplitude. Delta waves are primarily associated with deep sleep.

• Theta (3 to 7 Hz): Theta waves lie within the range of 3 to 7 Hz, with an

amplitude usually greater than 20 µ?. Theta waves are believed to be associated

with emotional stress, creative inspiration and deep meditation.

• Alpha (8 to 13 Hz): Alpha waves lie within 8-13 Hz with 30-50 µ? amplitude.

Alpha is the most active type of wave and possibly spans a wide range. Alpha
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waves are strongest over the occipital region of the brain and also over the frontal

cortex.

Beta (13 to 30 Hz): Beta waves lie within 13-30 Hz and usually have a low

voltage, anywhere between 5-30 µ?. Beta is the brain wave, which is usually

associated with active thinking, active attention and problem solving [12-14].

?^?^?^?/?^?-
0.5 - 3 Hz

Dèlta wave

4-7Hz

Theta wave ,i*#^KVy^/s?\yw?^J^/^^
8 - 13 Hz

Alpha wave

14 Hz
Beta wave

^Á$^WV¥/^

Figure 5: EEG Wavegroup, as described in section 1.2 [15].

Though EEG is mainly used to measure the electrical activity of the brain, it has

to be noted that it can also be used to measure the eye-relate activity. The potential

difference generated by the movement of an eye is captured by the EEG and this activity

of eye-movement tracking by EEG instrument is called as electro-occulography (EOG).

An EEG electrode is usually placed near the eye to measure this activity. The EOG can

be used to measure the blinking rate and the inter-blink interval.



1.3 Stroop Test

A person's mental stress depends on his/her knowledge and experience related to

the problem and many other cognitive parameters. With the same design problem,

different designers will have different mental/emotional stress. If the brain-related

activity is used to assess or quantify the metal stress (which is the motivation for the

present thesis), then different mental/emotional stresses will result in different brain

activities, leading to different EEG wave patterns. The ultimate aim is to quantify the

mental stress of the designer, while doing a design task, using the EEG data. However,

the first step in achieving this long term objective is to characterize the EEG data and to

develop a methodology to quantify a subject's mental stress using this data. In order to

achieve reliability and confidence in the characterization and quantification

methodologies, it is extremely important to remove the artifact that could possibly be

introduced due to the subject's background knowledge and experience in design.

Therefore, it is necessary to define a non-subjective baseline to analyze the EEG data

from different designers. To achieve this goal Stroop test can be used. Stroop test was

invented by psychologist John Ridley Stroop in 1935 [16]. Stroop test, a color naming

task, is a classical paradigm in neurophysiologic assessment of mental fitness [17]. The

Stroop test is presentation of interference in the reaction of the task. This test is

controversial about the exact mechanism responsible for this test, however, this tool is

widely used for various cognitive-perceptual processes [18].

1.4 Objectives and Scope

Motivated by
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(i) the fact that variation in mental/emotional stress results in variation in the electrical
activities of the brain and different electrical activities result in different EEG wave

patterns and,

(ii) the Yerkes-Dodson law which relates the designer's stress to his/her performance

and keeping in mind the long-term target of quantifying the mental stress, using EEG

data, to validate Yerkes-Dodson law, the principle goals of this thesis are to characterize

the EEG data obtained during the stroop test and to qualitatively demonstrate a relation

between the designer's stress and his/her performance during the stroop test. The specific

objectives and the scope of the project are as follows:

1 . Develop a stroop test and a methodology to calculate the performance.

2. Develop an experimental protocol to record the EEG of a subject during the

stroop test.

3. Record the EEG data on different scalp locations during the stroop test.

4. Develop an algorithm to filter raw EEG data, to segment it and to calculate

absolute and average powers of different frequencies of brain activity for each

difficulty level of the stroop test.

5. Develop a methodology to calculate the subject's performance from the stroop

test, for each difficulty level.

6. Study changes in different powers for each difficulty level and identify the

dominant power for each scalp location.

7. Observe the trend in the variation of different powers and performances

simultaneously for each difficulty level of the stroop test and identify, if

10



possible, a qualitative correlation between the EEG band powers and the

performance.

1.5 Thesis Outline

The literature review (i) summarizing the key findings in the field of analysis of

various human responses using EEG and (ii) explaining in detail background knowledge

of EEG, EOG and Stroop test is in chapter two. Experimental methods and protocol and

EEG data analysis methods are covered in chapter three. Chapter 4 contains the results

and their discussions and the conclusions are summarized in chapter five. Figure 6 shows

the thesis overview and organization in a pictorial format.
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2. Literature Survey

2.1 Introduction

A detailed study and survey, to get familiar with and to understand the intricacies

of the functioning and operation of and accurate data recording from the EEG, was

performed. The study of various signal processing techniques that are needed to apply to

the raw EEG data to obtain meaningful results was also done. A systematic literature

survey of the studies involving the analysis of different mental responses, like fatigue or

workload, based on the EEG and EOG data was undertaken. The key and necessary

details of the above mentioned studies are described in this section.

A brief review of Stroop test is also included in this chapter.

2.2 EEG and data recording

2.2.1 EEG electrodes

EEG records the cortical spontaneous electrical activity at the scalp. Different

types of electrodes can be used to measure the electrical activity of brain using EEG. The

electrodes are instrumental in data recording since they form a link between the electrical

generators in the brain and the EEG instrument. EEG electrodes are nothing but metal

cups that are held against the scalp and are connected to the EEG amplifiers using

conducting wires. A conductive gel is applied to hold the electrodes on the scalp. The

electrodes can be made up of various metals and their compounds like gold (Au), silver

(Ag), platinum (Pt), silver chloride (AgCl), to name a few. Different metals develop

different kinds of voltages with the same electrolyte [12].

13



2.2.2 Montages

The pairs of electrodes connected to each amplifier of the EEG machine are called

a montage. The three types of montages are as follows [12]:

1) Bipolar montage: Each channel represents the difference between two electrodes.

For example, if channel 1 represents "Fpl-F3" then it means that it represents the

difference in voltage between the FpI electrode and the F3 electrode.

2) Referential montage: Each channel represents difference between one scalp

electrode and one reference electrode. The reference electrode is same for every

channel. The reference electrodes are attached to the earlobes.

3) Average reference montage: Activities from all electrodes are measured, summed

together and are then averaged. This averaged signal is used as a common
reference for each channel.

2.2.3 EEG data locations and Artifacts

As mentioned in section 1.2, different brain areas are related to different

functionalities. Though it is not very obvious to distinguish, one may think that the EEG

data measured from different scalp locations may correspond to different functionalities.

The four different locations in the brain, as previously discussed, are Fz (Frontal lobe),

Cz (Central lobe), Pz (Parietal lobe), Oz (Occipital lobe). Fz location represents

emotional control, Cz represents sensory and motor functions, Pz represents perception

and differentiation and Oz represents visual areas [19].

However, it has to be noted that all the electrical activities recorded by the EEG

instrument are not necessarily originated by the subject's brain, though those originated

from the subject's brain are only of interest. The other activities recorded by the

14



instrument are called as noise or artifacts. There are two main types of artifacts,

physiological and non-physiological. Physiological artifacts include the electrical signals

generated by the subject but other than those in the brain. Non-physiological artifacts

originate from different sources like radiation from light, electronic devices in the room,

power cables etc.

2.3 Physiological responses and EEG

2.3.1 Common usage of EEG in medicine

EEG is used extensively in clinical applications due its following benefits.

1) EEG can continuously monitor the brain function for a long period.

T) The associated cost is lower than that of other techniques.

3) EEG gives higher temporal resolution.

EEG is also used in the following clinical research purposes:

1 ) It monitors epilepsy, alertness and brain death.

T) EEG detects epileptic seizures

3) It also monitors animal and human brain development.

2.3.2 EEG spectral power

Engineers and designers are mostly in heavy mental activities all the work places.

Hence a tool to measure or quantify the mental activity becomes very important. During

any mental activity the physiological variables also change. Parameters of the autonomic

nervous system such as pupil diameter, galvanic skin response and heart rate change

because of excessive mental workload, mental stress or fatigue. But it is intuitive that the

bioelectrical activity of the brain is more closely related to the mental activity than any of

15



the above mentioned parameters. In the past, some research has been directed towards

measuring this bioelectrical activity of brain using the EEG during some type of

cognitive workload and analyzing it using power spectral analysis. The key findings are

summarized below.

The spectral power of EEG recorded signals contains information of the electrical

activity discharges synchronously by many neurons. Kiroy et al. found out that the EEG

spectral power changed after a prolonged mental activity consisting of attention and

calculating tasks. All the frequency bands (including slow and fast EEG waves) increased

during 6-hours of non-stopped prolonged activity of attention and calculating task and the

effect remained same even in the resting period after the session [20]. The EEG power

analysis also shows the capacity or performance of cortical information. Klimesch

(1999) suggested that the EEG alpha and theta oscillations were related to cognitive and

memory performance. They also suggested that, during any event related task, an

increase in the theta power and a large decrease in the alpha power indicate a good

cognitive and memory performance. The other finding was that small theta power and

larger alpha power showed good task related performance [21]. The short-lasting activity

in the brain is detected by the alpha band of the EEG and hence visual perception could

possibly be detected by this band because it is short-lasting activity [22].

It has been observed by Boksem et al. that, during any mental task, when the

alertness of the subject drops, the EEG waves shift from fast, low amplitude to slow, high

amplitude (indicative of mental fatigue since the attention drop could be due to the

fatigue). Boksem et al. specifically showed that the theta and lower-alpha EEG band

power increased with the decrease in the subject's attention. They also observed that

16



reaction times, misses and false alarms increased during the lack of attention and this

indicated a decreasing performance [23]. Uetake and Murata found out that the alpha-

band power decreases after the completion of a task (post-task). They suggested that the

activity of central nervous system slows down due to mental and physical fatigue [24].

Murata et al. evaluated mental workload using wavelet transform. They calculated theta,

alpha and beta frequency bands and the time at which the maximum power appeared for

these three frequency bands. As the cognitive task difficulty level increased, the time for

which the brain works actively also increased. They concluded that these findings were

sensitive indicators of mental workload [25].

2.3.3 Event related potentials

Event related potentials (ERP) are the reflections of the neural activity of the

brain to specific cognitive events. ERPs are estimated by recording EEG from the scalp

of the subjects during any cognitive task and then averaging epoch's time-locked to a

particular event. The time locking event is the external stimulus and the response is

elicited by the subject. As the EEG reflects millions of simultaneous ongoing brain

processes, the response of the brain to a single event or stimulus is not usually visible. To

see the brain response to a particular event or stimulus, many trials (100 or more) are

conducted and the results are averaged, causing random brain activity to be averaged out

and the relevant ERP to remain. The measurement of ERPs is a tool for mental

chronometry. There are various applications of ERPs related to human factors including

assessment of mental workload, mental fatigue and evaluation of mechanism of

vigilance.
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Figure 7: P300 event related potential.

A large number of studies of ERP in human factor were associated with the

assessment of mental workload. In the ERP study of mental workload, many researchers

studied the P300 component, which was discovered by Samuel Sutton, Margery Braren,

Joseph Zubin and E. R. John in 1965 [26]. The P300 signal is measured usually from the

parietal lobe of the brain. The P300 is a slow positive wave with the mean latency at

around 300ms, as shown in Figure 7. The P300 components are useful in identifying the

depth of cognitive information process. The P300 (also referred as P3 sometimes) can be

recorded as a positive deflection in the voltage at a latency of roughly 300 ms in the EEG

(cf. Figure 7) [27]. P300 amplitude reflects the amount of attention associated with the

stimulus when some mental activities are employed [28]. Kutas et al. found that increase

in the difficulty level of the identifying target stimuli would affect the P300 latency. P300

latency got prolonged with increasing difficulty level of the identifying target stimuli.



Uetake and Murata also reported the same observation but, additionally, they also found

out that the P300 amplitude decreased after the experimental task (Post task) with

increase in the difficulty level of the target. This finding is an effective measure of mental

fatigue [24]. Parasuraman et al. also reported that as the difficulty level increases the

P300 amplitude decreases [29].

2.3.4 EIectrooculography (EOG)

As mentioned before, EOG measures the change in electrical activity due to the

eye movement. It has to be noted that the subject's eye blink is an indication of the

information related to the task that subject is performing. It has been suggested that the

eye blinking rate increase with the increase in subject's attention and alertness and hence

could possibly be used as an indication of the mental stress. Inter-blink-interval (IBI)

refers to the time interval between two blinks. It has been reported that as the difficulty

level of the task increases, the IBI of the subject also increases [6]. Blinking rate is also a

parameter that can be obtained from EOG and is believed to be related to the cognitive

state of the subject and is believed to be a potential candidate for assessing stress [30].

The reduced blinking rate indicates an increase in the visual demands on the task [31].

Increase in blinking rate is also believed to be an indicator of fatigue [32, 33]. Veltman et

al. measured mental workload with eye blinks and they observed that as the visual

demand of the task increased, the IBI also increased. They emphasized that this

physiological measure is very closely related to the subject's mental stress [34].
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2.4 Stroop Test

2.4.1 Stroop Test and EEG

In cognitive physiology studies, the stroop test is the most widely used task. The

effect of any stroop test on the subject can be best investigated using the P300 ERP

because it provides independent measures of stimulus evaluation time and attentional

requirements [35]. Rebai et al. also found out that ERPs were similar for reading

concordant and discordant stimuli. They found similar results for mental naming of a

color associated to the written name of the same color. Another important finding is

related to the mental naming of the color associated to the written name of a different

color and it is demonstrated that the N400 wave in the Cz location is more significant in

this case [36]. Liotti et al. suggested that the anterior cingulated cortex is initially

activated by the stroop test, followed by the activation of the leñ temporal-parietal cortex

[37]. Schack et al. studied the instantaneous EEG coherence analysis during the stroop

test and they found out that the 13-20 Hz frequency band is sensitive to the

discrimination between the congruent ("red" written in red color) and the incongruent

task ("red" written in any other color). They also found higher coherence in left frontal

and left parietal areas during the incongruent task than during the congruent task [38]. Xu

et al. studied the effects of tobacco smoking on topographic EEG during the stroop test.

They found that tobacco smoking significantly depressed delta and increased alpha and

beta activity and it also slightly increased the effect of the stroop. Smoking did not

improve the subject's performance in the stroop test [39].
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2.4.2 Stroop Test and other physiological signals

Other than EEG, many other physiological signals are also studied during the

stroop test, such as Heart Rate Variability (HRV), skin conductance, pupil diameter etc.
Hoshikawa et al. studied the effect of the stroop test on the autonomic nervous system by

analyzing the heart rate variability [40]. They found out that, during the stroop test, the

RR interval decreased and the parasympathetic and sympathetic nervous system

indicators remained unchanged. Salahuddin and Kim also detected the mental stress (as

the ratio of low frequency to high frequency components) by HRV. They also measured

the galvanic skin resistance and finger temperature. It was observed that the skin

conductance increased during stroop test and finger temperature decreased. In their work,

RR intervals and heart rate results remained unchanged between the baseline and the

stroop test. From these results they concluded that stroop test possesses the capacity to

produce cognitive stress [41]. Siegle et al. found out that the pupil dilation was larger in

an incongruent task than in the congruent task. It showed that pupil dilation reflected

cognitive load of the task [42].
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3. Experimental Methods and EEG data Analysis

3.1 Introduction

This chapter includes (i) a detailed explanation of the stroop test used in this work

and its different difficulty levels, (ii) description of the experimental setup and

experimental procedure, (iii) mathematical and physical details of the processing of the

raw EEG data and its analysis, (iv) description about the EEG instrument used in this

work, procedure for electrode placement, data acquisition and safety and other

precautions and, (v) relevant details of the subjects employed in this work.

3.2 Stroop test

Stroop test was used in the present work as a stressor/stimulus for the subject.

Stroop test, a designed computer game, presented a color name (referred as stimulus

word) on the subject's computer screen and this color name was displayed in a color that

was same as or different from that the stimulus word refers to. The subject had to select

the answer corresponding to the color of the word. For example, with a GREEN word in

BLUE color, the subject had to select the word BLUE in the answer list. Our Stroop test

contained six colors: RED, BLUE, YELLOW, PURPLE, GREEN and BLACK, and six

difficulty levels as listed and described below:

1) Difficulty level 1 (DLl): A stimulus word is displayed in the color referred by itself

and each word in the answer list was displayed in the color referred by itself. For

example, the stimulus word 'RED' was written in red color and the word 'RED' in

response list was also written in red color (cf. Figure 8).
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Match the coloi with the word

Red

Match thecolor with the word

SrëeW) (TtecT)

Figure 8: Difficulty Level 1 (DL2), also referred in the thesis as "Congruent-

Congruent".

2) Difficulty level 2 (DL2): A stimulus word was displayed in the color referred by itself

and each word in the answer list was displayed in black color. For example, the

stimulus word 'RED' was written in red color and the word 'RED' in response list

was written in black color.

Match iliecolor with the woi d

Red

Mjtch (he rotor with the word

feHow) (ërëen) (lted
1j\ùe) (furpfe

Figure 9: Difficulty Level 2 (DL2), also referred in the thesis as "Congruent-Black".

3) Difficulty level 3 (DL3): A stimulus word was displayed in a color different from
that it refers to and each word in the answer list was displayed in black color. For
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example, the stimulus word 'RED' was written in blue color and the word 'RED' in

response list was written in black color.
M^tch the color with the word

Red

MjicIi the rotor with the word

fellow) (G ree ri) ( Red

("Blue) (Purple

Figure 10: Difficulty Level 3 (DL3), also referred in the thesis as "Incongruent-
Black".

4) Difficulty level 4 (DL4): A stimulus word was displayed in a color different from

that it refers to and each word in the answer list was displayed in the color

referred by itself. For example, the stimulus word 'RED' was written in blue color

and the word 'RED' in response list was written in red color.
Matdi ihecolor with !he word

Red

Mitch the color with the word

Sreeri) ???G)
( Blue

Figure 11: Difficulty Level 4 (DL4), also referred in the thesis as "Incongruent-

Congruent".
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5) Difficulty level 5 (DL5): A stimulus word was displayed in the color referred by

itself and each word in the answer list was displayed in a different color that it

refers to. For example, the stimulus word 'RED' was written in red color and the

word 'RED' in response list was written in yellow.
Motril llie color with the word

Red

MjHcIi the color with »he word

si (Purple) ("Blue^)
ii'eìkmh (oreen"

Figure 12: Difficulty Level 5 (DL5), also referred in the thesis as "Congruent-

Incongruent".

6) Difficulty level 6 (DL6): A stimulus word was displayed in a color different from

that it refers to and each word in the answer list was displayed in a different color

that it refers to. For example, the stimulus word 'RED' was written in green color

and the word 'RED' in response list was written in yellow.
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Figure 13: Difficulty Level 6 (DL6), also referred in the thesis as "Incongruent-

Incongruent".

During all the above difficulty levels of the stroop test, the subject was presented

the stimulus word for 500 milliseconds. Then the response screen was displayed for 1500

milliseconds maximum in which the subject had to click on the answer. This process of

observing the test screen for 500 milliseconds and responding in less than 1500

milliseconds is referred as a Stroop task. The time interval between two stroop tasks was

kept as 1000 milliseconds. The EEG data sampling frequency was taken as 200 (per

second).

3.2.1 Design of Stroop Experiment

The complete stroop test, comprising of the above described difficulty levels, was divided

into three profiles described below.

Profile 1 - The profile 1 consisted of 60 screens. Each difficulty level had 10 screens on

the computer. In this profile the sequence of the difficulty levels was kept as follows:

Difficulty level 1 ¦> Difficulty level 2 -> Difficulty level 3 ¦* Difficulty level 4 ¦>

Difficulty level 5 ·> Difficulty level 6

26



Profile 2 - The profile 2 consisted of 60 screens. Each difficulty level had 1 0 screens on

the computer. In this profile the sequence of the difficulty levels was kept as follows:

Difficulty level 6 ¦> Difficulty level 5 ¦> Difficulty level 4 ¦> Difficulty level 3 ->

Difficulty level 2 "^ Difficulty level 1

Profile 3 - The profile 3 consisted of 60 screens. Each difficulty level had 10 screens on

the computer. In this profile the sequence of the difficulty levels was kept as follows:

Difficulty level 4 -> Difficulty level 3 ¦* Difficulty level 1 ¦> Difficulty level 6 ¦>

Difficulty level 2 -^ Difficulty level 5

3.3 Experimental setup and procedure

3.3.1 Subjects

Experiments were conducted on eight different subjects of different ethnic

backgrounds. All the subjects belonged to the age-group of 20-35 years and were with or

without glasses. English was the native or working language for them. All the subjects

were male. Female subjects were purposely not taken for the present study because the

EEG electrodes had to be attached to the subject's scalp directly (without EEG cap) and

log hair in females used to cause a lot of problem in fixing the electrodes on the scalp

(cleaning the hair to remove the EEG conductive gel after the experiment was also an

issue).

3.3.2 EEG instrument

The GrassLab instrument was used in this work for the EEG experiments. To be

specific, the 15LT model of the GrassLab instrument was used. The instrument had two

15A94 QUAD amplifiers. The 15A94 has high frequency response to 100 Hz, suitable
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for clinical applications in EEG, and Polysomnography (PSG). 15LT model provided a

bipolar electrode board; model F-15EB/B1 electrode board. Each differential amplifier

channel has two active inputs; Gl and G2, which are accessible via the electrode board.

Each differential amplifiers two active inputs are connected to the electrode board via the

bipolar electrode interface module. Gl and G2 are grouped by channel number. This

arrangement is the most flexible, but requires external electrode linkers to allow

common-reference derivations. Electrode linkers, model F-EL2, are provided with al

bipolar systems to allow common reference derivations.

3.3.3 EEG recording technique

The 10-20 system is an internationally recognized method for placement of

electrodes on the subject's scalp, and is shown in Figure 14 [43]. The numbers 10 and 20

indicate that the actual distances between adjacent electrodes are either 10% or 20% of

the total front-back or right-left distance of the skull. To identify each lobe, each site has

a letter and to identify hemisphere location, each site has a number. Frontal- F, Temporal-

T, Central- C, Parietal- P, and Occipital- O. Z refers to an electrode placed on the

midline. Even numbers (2, 4, 6, 8) refer to the right hemisphere and odd numbers (1, 3, 5,

7) refer to the left hemisphere. Nasion is point between the forehead and nose. The Inion

is the bump at the back of skull [44].
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Figure 14: 10-20 Electrode placement, top view and profile view [43]

Following the 1 0-20 system, EEG signals were recorded from four different scalp

locations (Fz, Cz, Pz, Oz) during the stroop test. It provides generalized activity of a

particular lobe. As briefed before, Fz location is for emotional control, Cz location is for

sensory and motor functions, Pz is for perception and differentiation, Oz is for visual

areas [19]. EOG was also recorded to observe the blink rate and inter-blink-interval from

eye.

3.3.4 Electrode placement procedure

¦ Take measurement of the head of the subject and mark locations on the scalp

following the 10-20 scalp location manual.

¦ Locations to be marked for electrode placement are

1) Fz-reference electrode left ear lobe

2) Cz- reference electrode left ear lobe

3) Pz- reference electrode left ear lobe

4) Oz- reference electrode left ear lobe
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5) Heart rate (on left hand)-reference right hand

6) Left Eye-reference electrode left earlobe

¦ After marking the locations, scrub that location with alcoholic pads and Nuprep gel.

¦ Apply the EEG paste on every location.

¦ Fill the cup of the electrode with a glob of EEG paste and then fix that electrode on

that the marked location.

¦ Once the electrode is fixed on the scalp, apply EEG paste over the electrode and

around the edge.

¦ Put a 2x2 cm gauze pad on the electrode after applying the paste on the top of the

electrode. This is to make sure that the electrode is secured and chances of loosing the

contact with the scalp are less.

¦ Before starting the EEG equipment, turn off the lights and disconnect the phone and

internet in the lab.

¦ Start the EEG equipment for recording brain signals and do filter and amplitude

setting in the instrument itself.

¦ It is very important to observe the raw data for 10 mins or so to make sure that the

electrodes are securely connected to the scalp and that you are not loosing any data

due to loose connections.

3.3.5 Experimental setup

In order to get accurate data, external stimuli like room lighting and

environmental temperature were kept constant. The experimental setting is shown in

Figure 15. Consent form was given to subject before his arrival in the lab. The consent

form contained all the information about the experiment. Subject was asked to sign the
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consent form and after signing the consent form experiment setup would start. Subjects

were also explicitly informed about not moving and sitting straight in front of the desktop

during the experiment. Subjects were also asked to sit in front of the computer at ease for

the first 6 minutes in a pre-Stroop test stage, followed by the Stroop test (which lasted for

another 9 minutes), and finally the subjects were again asked to sit in the relaxed state for

an extra 5 minutes, which is called the post-stroop test stage.

Before starting the experiment, the subject was allowed to play a few trials to get

the knowledge as well as to get acquainted with the stroop test. In general, it took the

subjects around eight to ten minutes in the trial stage before the experiment started. EEG

amplifier settings were kept at 200 Hz frequency and 10 second time constant. The low

frequency filter (LFF) was at 0.1 Hz and the high frequency filter (HFF) was at 30 Hz

setting in the GrassLab instrument to filter the noise in the raw EEG data. A 60 Hz notch

filter, available in the instrument must also be used to remove the noise resulting from the

power cables present in the room. Each EEG measurement session lasted approximately

20 minutes. After the recordings were completed, the subject was asked to wash his hair.

The EEG paste provided by GrassLab was used and can easily be removed with water

only.
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Figure 15: Experiment Setup for the EEG data recording.
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Figure 16: Experimental and Analysis procedure.

3.4 Data Processing: Filtering and Segmentation

3.4.1 Data Filtering

Data filtering is a treatment method for the raw EEG data in which some

attributes of the data are selected to preserve and some data to filter out. Scalp EEG data

is susceptible to various non-physiological signals that could interfere with the recording



electrodes. These interfering noises can cause a major problem in reliable analysis of the

subject's EEG data during the stroop test. Also, many physiological signals of the subject
himself can interfere with his own EEG. In filtering, both, the spectral components and

noise, are significantly important issues. The filters are designed in such way where the

desired spectral components are only selected or are passed and the noise gets rejected.
There are two main kinds of filters:

1) Analogfilter - An analog filter is a hardware based filter that uses electronic circuits,

to reduce noise, video-signal enhancements etc. Analog filters were not used in this

thesis.

2) Digital filter- A digital filter uses digital processor which performs mathematical

calculations on sampled values of the signal. Digital filters for EEG data processing

are implemented as software programs and they computer power. There are basically

two types of filters. Finite impulse response (FIR) and Infinite impulse response (IIR)

filter.

• FIR filter - In the FIR filter, the impulse response is finite because its response settles

back zero in a finite number of samples. The equation defining the output of this filter is

as follows:

ih(n)} = {Mfo) + M<n - 1) + - + hqS(n- q)} (1)

The transfer function of a qííl order FIR filter is given by the z-transform of its

impulse response.

H(z) = ZU0 Hk)z~k = "^ +h-" *k«' (2)
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• IIR filter - The IIR filter has an impulse function that is non zero over infinite length

of time. Examples of IIR filter are Chebyshev filter, Butterworth filter and the Bessel

filter.

{/? (?)} = {ft(0)£(n) + /i(l)£(n- 1)+ ¦-·} (3)

In the z-domain the IIR filter can be analyzed in terms of its transfer function as:

HiZ)=Lg0KQz-* (4)

H(z) = Ü00 = g^^ (5)

In this thesis, the digital IIR low-pass digital Butterworth filter was used to filter

the noisy data from raw EEG signal. The digital filter was implemented using the

MATLAB's signal processing toolbox. MATLAB function "butter" allows the design of

lowpass, bandpass, highpass and bandstop Butterworth filters. In the digital domain, (b,

a)=butter (n, Wn) designs an order ? lowpass digital Butterworth filter with normalized

cut-off frequency Wn. It returns the filter coefficients in length n+1 row vectors b and a,

with coefficients in descending powers of z. Cut-off frequency is that frequency where

the magnitude response of the filter is Pf2. For butter, the normalized cut-off frequency

must be a number between 0 and 1, where 1 corresponds to the Nyquist frequency, tt-

radians per sample.

After using the 5th order Butterworth filter, zero-phase digital filtering was used.

It processes the input data in forward and reverse directions. After filtering in the forward

direction, it reverses the filtered sequence and runs it back through the filter. The

advantage of zero-phase digital filtering is that it eliminates non-linear phase distortion.

35



Figure 17(a) and (b) show a 10 second raw data and the corresponding filtered data for a

Fz channel recording of two consecutive stroop tasks, respectively. In some cases this

signal processing is not enough, so in that case additional processing is necessary for

analysis.
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Figure 17: A sample (a) Raw EEG data, (b) Filtered EEG data.
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To attenuate the signal at 60 Hz, a special notch filter was used with the EEG

instrument. It is to remove artifact produced by electrical power lines. It is also known as

band-stop filter. A notch filter passes all the frequencies except those in stop band

centered on a center frequency.

3.4. 2 Data segmentation

The filtered EEG data was then segmented according to the stroop tasks' timings.

In the stroop test, three profiles with six difficulty levels were used. Each profile had 60

screens. Each difficulty level in each profile had 10 screens. Time duration for the Stroop

test is nine minutes (3 minutes for each profile and 3 seconds per screen, as described in

section 3.2). Therefore, the EEG data was segmented into 3 second fragments. Data

segmentation was done in MATLAB. To segment the filtered EEG data "mat2ceH"

function in MATLAB was used. The syntax is

c = mat2cell (x, m, n)

where ? -^ row ? column matrix

m "^ number of rows

? "^ number of columns

In this work, the data segmentation was done in five steps for the analysis of EEG data

for each difficulty level and the segmentation scheme is illustrated in Figure 18.
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ure 18: Segmentation scheme for the EEG data collected during the stroop test.

In step 1 , the whole EEG data was segmented into three parts, pre-stroop, stroop

and post-stroop because analysis had to be performed only on the stroop data.

Figure 1 9 shows the segmentation of a sample EEG data (data-points) for one

channel into three parts as follows.

Pre stroop -72400 = 362sec><200 (sampling frequency = 200 per second)

During stroop -108000 = 540secx200
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Figure 19: Segmentation of the filtered EEG 20 min (1200 seconds) data.

In the second step, the during-stroop data was again segmented for further analysis

because the stroop-test consisted of three profiles. The during-stroop test EEG data

segmented into 3 parts (36000x3) is shown in Figure 20:

1) Profile 1 - 36000 = 180secx200

2) Profile 2 - 36000 = 180secx200

3) Profile 3 - 36000 = 1 80secx200

39



During S troop Test

180000 Data

points
540 seconds

Profile 1

36000 Data

points
I SO secomis

Profile 2

36000 Data

points
ISO seconds

Profile 3

36000 Data

points
ISO seconds-

Profile 2
Profilen

Il IH

Profile 3

I ?

il.

Ü

l||
Hi !

200 300 400
Time (Seconds)

500

Figure 20: Segmentation of During EEG 9 min (540 sec) data corresponding to

Stroop test for one channel.

Since each profile in the stroop test had six difficulty levels, the segmented data for

each profile was further segmented as follows.

Difficulty Level i - 6000 = 30sec><200; / = 1 ... 6.

ure 21 shows the segmentation of a sample profile into six difficulty levels.
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Figure 21: Segmentation of Profile 1 EEG data corresponding to Stroop test for one

channel.

In the fourth step, each difficulty level was segmented in ten screens (600x10). Figure

22 shows the segmentation of difficulty level 1 into 10 screens of profile 1 for

channel Fz.

41



ULI Sci eoi 1 Screen 2 Screen 3 Screen 4 Screen 5 Screen 6 Screen 7 Screen 8 Screen 9 ScreenIU

6000
Data

points
JO sec

600
Data

points
3 .sec

600
Data

points
3 sec

600
Data

point;;
3 set

600
Data

points
3 sec

600
Data

points
3 sec

600
Data

points
3 sec

600
Data

points

600
Data

points
3 sec

600
Data

points
3 sec

600
Data

points
3 sec

1.5

1
?

f 0.5

Screen
1

E
< oil

-0.5

-1

ur-
Ms "if

ti'i

1

' ^ it lift1 IHla,"
S'l

i.»

«I

il ¡'

0 10 15 20
Time (Seconds)

¦ Screen
: 10

? s

If

25 30

Figure 22: Segmentation of each difficulty level EEG data corresponding to each

screen of Stroop test for channel.

• In fifth step, each screen was segmented into three different parts as follows:

Reading part - 100 = 5 00msec ? 200

Response part - 300 = 1 .5sec*200

Rest part - 200 = lsecx200

Figure 23 shows segmentation of screen 1 in the EEG data for difficulty level 1 of profile

1 during the stroop test. It can be observed from this figure the amplitude is higher in the

response part of the screen.
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Figure 23: Segmentation of each screen EEG data into three different parts.

3.5 Data analysis

3.5.1 Power Spectral density

The power spectral density (PSD) is the average distribution of power of a signal

with respect to frequency. If the power is concentrated in the low frequency region, it

means that the signal varies very slowly; if the power is concentrated at a fundamental

frequency of rhythm, it means the signal tends to be rhythmic; if the power of the signal

is distributed in different frequencies, then the signal lacks its rhythmicity [45].

There are two types of power spectra estimation methods and they are as follows:
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1) Non-Parametric method

2) Parametric method

The main advantage of the parametric method over the non-parametric method is

that it gives better results than non-parametric method when the data length of the signal

is relatively short [46-50].

3.5.1.1 Non-parametric methods

In these methods, PSD is estimated directly from the signal itself. The

periodogram is the simplest non parametric method and the modified version of the

periodogram is the Welch's method. The discrete Fourier transform (DFT) is one of the

popular methods of Fourier transform, which is used in Fourier series. Fourier transform

transforms original function into its reciprocal space. It transforms the time domain

analysis into the frequency domain analysis. The Fourier transform can be expresses as

X(f) = j~xx(t)e-i2jlftdt (6)
DFT requires discrete input function and whose non-zero values have limited duration.

The DFT can be efficiently calculated using the Fast Fourier Transform (FFT) method

[46].

^=2^*„e-i2*kt (7)
where

X-k — represents the amplitude and phase of the sinusoidal components of signal Xn

Xn — input signal

N - total number of samples
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The power spectral estimation by the FFT is given as

P(k) = HX(Tc)I!2 (8)

3.5.1.2 Parametric methods

In these methods, PSD is calculated from a signal that is assumed to be created

with equations, with unknown coefficients to approximate. There are various regression

methods to estimate the parameters, such as least squares, Yule-Walker and Burg

methods are the common parametric methods.

In this work, autoregressive model was used for the spectral analysis. In

parametric methods, autoregressive (AR) method is the more frequently used method

because of the ease in estimation of autoregressive parameters. The AR model is defined

as:

*n = - ZLi a{k)x{n - k) + W(Ti) (9)
wherew(n) is the white noise and CL(Ji) are the AR coefficients. AR model can be

characterized by AR parameters ((Z[I], Cl[2], ...., Cl[p]}. The PSD is then given as

WZ) = J^ CO)
where

A (/) = 1 + f1 e~ì2 *f + ¦ ¦ ¦ + f?e"^ (11)
AR spectral estimation by Burg method

For the PSD calculation, the parametric Burg method was used in this thesis. Burg

method is considered as the most reliable method, which provides reliable parameter

estimates as well as guaranteed stable estimated model (This is why Yule-walker should

not be used for autoregressive modeling). The Burg AR method is based on the
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minimization of the forward and backward prediction errors and estimation of the

reflection coefficient [51, 52].

PBURG (D = ? vp ,- ,,, -j-,,t?-?2 ' 'íi+SG .. a„{fc e- J2";*1·!

where

S = ^p +êbtP (13)
A separate computer code was not written in this thesis for the Burg method and

standard MATLB tools were used. There exist several syntaxes for the Burg method,

however, the following syntax was used in this thesis.

[Pxx, fj = pburg (x, p, nfft, fs)

The above command returns Pxx, an estimate of the power spectral density of the

vector ?. ? is the discrete filtered EEG data (time signal), ? is the integer specifying the

order of an autoregressive prediction model for the signal. In normal awaken state, EEG

rhythms can be easily modeled using the 8th order model. This uses the sampling
frequency as an integer in hertz to compute the PSD vector and the corresponding vector

of frequencies. The unit of PSD is in power per Hz. The range of frequency depends on

nfft, fs.ana the input value of x. Figure 24 shows the PSD values during a sample profile

of the stroop data (9 min data when subject was doing the stroop test) for all four

channels.
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Figure 24: PSD for all four channels for profile 1.

After calculating the PSD, the absolute band power within each frequency band

was calculated during each difficulty level of stroop test.
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4. Results and Discussion

4.1 Introduction

The stroop test was conducted on all the subjects and the EEG data was recorded.

The data was then filtered and the power in each frequency band was calculated. The

performance of all the subjects in the stroop test was also calculated. This chapter

describes the method of calculating the performance based on the stroop test. The

variation of theta, alpha and beta power during all the six difficulty levels of the stroop

test for all the subjects was studied and are reported in this chapter. Their variation in

different channels was also studied and is discussed here. This chapter also discusses the

inter-relationship between the theta power and the performance of the subjects.

4.2 Performance from the stroop test

The performance of a subject during the stroop test is calculated by considering

the average response time of the subject and the percentage of incorrectness. With

increase in the difficulty level, subjects tend to slow down and are prone to make more

mistakes, thus deteriorating the performance. The formula used to calculate the

performance is

Performance = (2 -ß-t/T)

where ß is the incorrectness rate, / is the average response time over one stroop segment

and T is the maximum response time.
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The performance of each subject was calculated at each difficulty level in each profile.

The average performance of all the subjects at each difficulty level can be calculated by

taking an average over all the three profiles. Such an average performance is shows in

Figure 25.

Average Performance1 A, , * . i 1 ¡

Jill
Level 1 Level 2 Level 3 Level 4 Level 5 Level 6

Figure 25: The average performance of all the subjects during different difficulty

levels (also averaged over all the three profiles of the stroop test).

It can be seen from Figure 25 that as the difficulty level increases the subjects'

performance goes down, as expected. However, the difficulty level 4 is an exception. It is

difficult to precisely cite a reason behind it, however, it has to be noted that the difficulty

levels 1 through 6 were defined intuitively and there was no quantitative evidence

demonstrating this ranking. For example, it is intuitive that "congruent-congruent" will

be easy to identify than "congruent-black" or "congruent-incongruent". However, such

I
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type of intuitive ranking might be difficult when "congruent-incongruent" is compared

with "incongruent-congruent". Hence, from this point onwards, the difficulty levels are

mentioned using their names and not their numbers (e.g. writing congruent-congruent

instead of writing difficulty level 1). A detailed statistical analysis is required on a large

number of subjects to confidently rank these six cases in terms of their difficulty levels.

Such type of analysis was not performed in this thesis but is recommended.

4.3 Band power analysis

This section reports the analysis of the powers calculated for all four bands (Delta,

Theta, Alpha, and Beta) for all the four channels (Fz, Cz, Pz and Oz), arranged according

to the difficulty levels. As mentioned in chapter 2, different channels and different bands

are associated with different functionalities of the brain, however a clear demarkation is

almost impossible. The four channels studied in this thesis, if associated with the type of

functionality based on their locations, are:

• Fz - emotional/mental control.

• Cz- sensory and motor function

• Pz- percpetion and differentiation

• Oz- vision.

Though each channel is located on a different part of the brain, since each channel

in the EEG measures electrical activity of millions of neurons in the brain, there is bound

to be an interference of different electrical activities associated with different

functionalities in each channel of the EEG. This is also evident from the fact that all the
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four frequency bands powers (alpha, beta, theta and delta) are present in each of the
channel. In order to simultaneously associate any particular band power and its channel

location to a particular functionality of the brain, it is very important to calculate

individual band powers in each of the channel and compare their activities during the task

(stroop test). This is the reason that in this thesis, each band power is calculated seperately

for each channel and each profile. The reading part and the response part of the power was

separated and for each difficulty level, it was averaged over all the profiles of all the

subjects.

4.3.1 Theta Power
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Figure 26: Average thêta power of all the subjects during the reading and response

part of the stroop test in (a) Fz channel, (b) Cz channel, (c) Pz channel and (d) Oz

channel.

Figure 26 shows the variation in theta power during different difficulty levels of

the stroop test in all the channels. The theta power was calculated separately for the

reading and the response part, at each difficulty level. It can be observed from Figure 26

(a - d) that the average theta power, particularly in the reading part, is more in the Fz

channel than in any other channel. This is consistent with the facts that Fz channel

location corresponds to emotional and mental control and the theta frequency band is also

believed to be associated with mental/emotional stress. Hence, it completely makes sense

to observe a higher power for the theta band in channel Fz. This observation is also

consistent with the previous literature, which suggests that the frontal midline (Fz) theta
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power is useful to assess mental/emotional stress during any mental task and is a good

indication of the subject's concentration [53-55].

It can also be observed from Figure 26 (a) that when "Incongruent-Congruent" is

compared with "Congruent-Incongruent", the theta power is significantly higher for the

"incongruent" part, be it during the reading or during the response. Contrary to that, and

rightly so, when the reading and response part are same (Congruent-Congruent and

Incongruent-Incongruent), the difference in their theta powers is the least. The reading

part of the theta power is always higher for the incongruent part than that for the

congruent part, since, it is more difficult to perceive the incongruent part than the

congruent part and the subjects probably get more stressed during the incongruent part,

revealing a higher theta power. The above observations validate and are in agreement

with the belief that the theta power in the Fz channel is a measure of the

mental/emotional stress, since incongruent reading and response is definitely more

stressful than the congruent reading and response respectively and there will not be a lot

of difference in the person's mental stress when the reading and response part have the

same difficulty level. It can also be observed that the difference between the reading and

response parts of the theta power is maximum for the "Incongruent-Black" difficulty

level and the theta power for the reading part of this difficulty level is the least. This

slightly different behavior of the theta power in this difficulty level is synchronous with

the average performance of the subjects since at this same difficulty level (level 4 in Fig.

25), the average performance also shows a deviation from the trend.
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4.3.2 Alpha Power
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Figure 27: Average alpha power of all the subjects during the reading and response

part of the stroop test in (a) Fz channel, (b) Cz channel, (c) Pz channel and (d) Oz
channel.
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Figure 27 (a - d) shows the variation of the subjects' alpha power, in different

channels, during the stroop test with respect to different difficulty levels. The alpha

power was also calculated separately for reading part and response part separately. It can

be observed from Figure 27 (a - d) that alpha power during the reading part is

significantly higher in the Oz channel than in Fz, Cz and Pz channels. Not only it is in

agreement with the reported literature suggesting that the alpha power is more active in

the Oz region of brain during a vision related task [14, 22] but also validates the same

since the stroop test used in this work is also a vision related task. It also needs to be noted

that the alpha power in the Oz channel is always higher in the reading part than in the

response part and even for the response part, the alpha power is more in the Oz channel.

The other important observation for the alpha power in the Oz channel is that the

difference between the alpha powers in the reading and the response part is the maximum

for Congruent-Congruent and Incongruent-Incongruent levels. The reason for this could

be that the subjects find the (visual) transition easy since the reading and the response

parts are the same. It can also be noted that the alpha power in the response part is

slightly higher for congruent and incongruent parts than for black. If the alpha power in

the Oz channel is believed to be for visual detection, it can be said that the subjects find it

easy to identify the black (all color names written in black) than the congruent or

incongruent parts. This could be due to the fact that all of us are used to reading the text,

printed or on computer, written in black color.
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4.3.3 Beta Power
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Figure 28: Average beta power of all the subjects during the reading and response

part of the stroop test in (a) Fz channel, (b) Cz channel, (c) Pz channel and (d) Oz
channel.
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Figure 28 (a - d) shows the variation of average beta power at all the six difficulty
levels in all four channels. As mentioned before, it has been reported in the literature that

the beta is related to active concentration and thinking [12-14]. It can also be observed in

Figure 28 (a - d) that the beta power for the reading part is always higher than for the

response part, in all the channels and at all difficulty levels. This is in agreement with the

literature since the subjects are doing more thinking while trying to identify the color in

the reading part, thus reporting higher beta power in the reading part. There are no reports

in the literature that suggest the relevance/association of one particular channel with the

beta power, however, Figure 28 (a - d) suggest that the average beta band power is

highest in the Oz channel. It has to be noted that Oz channel is related to the vision and

since the task in this thesis, i.e. the stroop test, is a vision based task, the beta power

related to concentration is more prominently showed in the Oz channel in this work.

However, if the mental task given to the subjects is not vision based then there are

chances that the beta power may be more prominently observed in some other channel

and not in the Oz channel.

From Figure 28 (d), it can be observed that the beta power in Oz channel is more

in the congruent reading part than in the incongruent reading part and also in other

channels, it is very difficult to comment on the relationship between the beta power in

congruent and than in the incongruent part. It is difficult to comment on the precise

reason behind it, however, it can be said that the subjects' concentration drops in

incongruent reading parts since identifying the color is more difficult in that case and this

results in confusion and in lack of confidence, leading to loss in the subject's
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concentration. Since beta band is related to concentration and thinking, its shows lower

power in incongruent parts.

4.3.4 Relationship between the performance and EEG band powers
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Figure 29: Comparison of (a) the average theta Power in the Fz channel and (b) of

the performance of subject 1 and subject 2 at all difficulty levels.
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the performance of subject 1 and subject 6 at all difficulty levels.
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Figure 29 and Figure 30 show the comparison of the theta power and of the

performance of subjects 1 and 2 and 1 and 6, respectively. The comparison was done at

all the difficulty levels. The motivation behind this thesis is to investigate a relation

between the stress and performance during a mental task, however, there does not exists a

method which can be used to quantify the mental stress. Since it has been suggested in

the literature [53-55] (and demonstrated in this thesis) that the theta power in the Fz

channel corresponds to the subject's mental stress during a mental task, this comparison

between two different subjects' performance and theta power in Fz channel was

performed at all difficulty levels. The theta power at all the difficulty levels was taken for

the response part only. In this thesis, the performance was calculated based on the degree

of correctness and on the response/reaction time and since the attempt here is to compare

the performance and theta powers of different subjects, the theta power for the response

part was also chosen to be the one during the response/reaction time.

It can be seen from Figure 29 and Figure 30 that for the difficulty levels

Incongruent-Black, Incongruent-Congruent, Congruent-Incongruent, and Incongruent-

Incongruent, the subject which gave a better performance in the stroop task also exhibited

a higher value of theta power. However, a discrepancy to this trend can be seen in the

first two difficulty levels Congruent-Congruent and Congruent-Black. The subject that

performed better exhibited a lower theta power than the one that gave a lower

performance. The Yerkes-Dodson law suggests that as the mental stress increases the

performance increases and after reaching an optimal point in the stress, it drops. This

could mean that if two subjects are given a similar task which is independent of their

expertise, the person developing more stress would perform better than other if they are
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in the initial positive-slope side of the Yerkes-Dodson law curve. Since, it in this thesis, a

quantitative ranking of the levels of the stroop test according to their "difficulty" was not
done, it would not be possible to propose any correlation between the stress (based on

theta power) and performance. However, believing that identifying the incongruent task
would be more difficult than identifying the congruent task and that the stroop test used

in this thesis was not difficult enough to stress the subjects to a level where his

performance would drop with further increase, it can be said that these results are in a

qualitative agreement with the Yerkes-Dodoson law. However, with these results it is not

possible to comment on the possible reason behind the observation that for difficulty

levels Congruent-Congruent and Congruent-Black, the subject who gave a higher

performance showed lower theta power. Again, since, Congruent-Congruent is bound to
be an easier task than Incongruent-Incongruent, it is not possible that the stress level lies

on the negative-slope side of the Yerkes-Dodson law curve.
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5. Conclusions and Future work

5.1 Conclusions

An extensive literature review of the assessment of different physiological

variables using the EEG was performed. With the motivation of correlating the designer's

stress, calculated using the EEG recorded data of the designer, to its performance during

a design related mental task, experimental set-up was established in Dr. Yong Zeng's

research group. The stroop test was used as a mental task given to the subjects. A protocol

was developed to attach electrodes on the scalp, to record the EEG data while the subject

is performing the stroop test and to filter the raw EEG data obtained. A segmentation

scheme for the filtered EEG data, based on the timings of the mental task (stroop test),

was developed and implemented. Algorithms and mathematical methods to calculate the

power spectral density of the filtered and segmented EEG data were identified. Using

these algorithms and methods, power spectral density of each band of the EEG was

calculated from each channel. From the density, absolute power for each band was

calculated. The powers for the reading part and the response part of the stroop test were

separately calculated. No further analysis of the delta band was performed, since it is

usually associated with deep sleep.

Absolute powers calculated for alpha, theta and beta bands of each EEG channel

during all the difficulty levels of the stroop test were analyzed. The analysis of the theta

band (mental/emotional stress) power showed that this frequency band is more

pronounced in the Fz channel. It was also demonstrated that the theta band in the Fz

channel is the potential candidate for quantifying the mental stress. Similarly, the analysis
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of the alpha power (vision) demonstrated that it is more pronounced in the Oz channel.

The combined analysis of the alpha power in Oz channel and theta power in Fz channel

also showed that, in the color identification task such as stroop test, during the reading

and response part of the stroop test, black may not necessarily be more difficult than

congruent. The analysis of the beta power (concentration) showed that it was more

pronounced in the Oz channel but it could possibly be due to the fact that the stroop task

is a vision based task. Non-vision based mental tasks need to be given to the subject to

confirm this.

The comparison of theta powers in the Fz channel and the performance of two

different subjects indicated that the difficulty level of the stroop test is not high enough to

make the subject stressed enough so as to decline his/her performance (following the

Yerkes-Dodson law). Partial and qualitative agreement with the Yerkes-Dodson law was

also demonstrated.

5.2 Future work and recommendations

5.2.1 Future work

The present thesis, though not a quantum leap in correlating the designer's mental

stress with the performance, lays down the necessary and crucial foundation for

quantitative validation of Yerkes-Dodson law using the electroencephalogram. The

suggested future work is as follows:

• Develop a methodology to quantify the mental stress using the theta power in the

Fz channel.
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• Develop a stroop test with higher difficulty levels and quantitatively rank the

difficulty levels of the stroop test by doing a statistical analysis on a large

number of subjects.

• Find the relation between P300, eye blinks, inter-blink-interval and the difficulty

levels of stroop test. Study at which location P300 is dominant.

• If possible, quantification of mental stress using P300, eye blinks and inter-blink-

interval during stroop test.

• Compare the mental stress and performance relation obtained using the EEG with

that obtained using the P300, eye blinks and inter-blink intervals.

• After quantifying the mental stress using the stroop test, the next step is to

quantify mental stress during a design process.

• Integrating EEG, eye tracker, HRV, video and linguistic data to understand

designers cognitive process.

5.2.2 Recommendations

• In the experiments performed in this thesis, the electrodes were manually fixed on

the scalp of the subjects. Getting a good contact in this case was quite a

challenging task and required a lot of trials to achieve it. A lot of experimental

data and time was also wasted due to the loss of contact between the electrodes

and the scalp in the middle or towards the end of the experiment. In order to save

time and available experimental resources (including the time of the subjects

who agree to participate in the experiments voluntarily or for a very minimal

returns) and to get reliable data, it is strongly recommended to use the electrode

cap for future experiments.
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• The other recommendation is about the noise in the EEG data. Though all the

possible filters were used to eliminate the noise in the data, it is strongly

recommended to somehow reduce the noise that is generated due to the

ventilation system in the lab. To avoid this kind of noise, a change the location of

the lab or the use sound proof cabinet is recommended.

• Performing the data analysis separately for each segment and repeatedly

modifying the MATLAB codes for different segmentation scenarios takes a lot

of time. This problem will be further aggravated while segmenting the design

task related EEG data. Though not reported in the thesis, a graphic user interface

(GUI) was also developed in this work. The GUI developed should be

generalized for further analysis.
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Appendix

GrassLab Configuration and Operation details:

1) Open Grasslab window on the computer screen then go to Start » Apply
configuration

2) In Apply configuration choose Input Channels tab. Enter a sample rate in the
Master Sample Rate box.

3) Select channel from the Analog input channel list, which is located on the left
side of the window.

4) Select whether to acquire the channel in Grasslab recorder. To acquire the
channel, ensure the Acquire Channel in Recorder option is checked. By default
all channels are to be set. Check marks in the analog input channel list indicate
channels that will be acquired.

5) After applying Input channels choose Display Views
6) Enter a name for the display view in the Display View Name Box. Then

choose Add button to the right of this box. The display view will be added to
All Display Views list.

7) Add necessary input channels to the display view. Select an input channel from
the Input Channels list. Then choose the Add button to the right of the Input
channel list.

8) Adjust properties of the channels in the Display Channels list.
9) When you are finished all setting then save this configuration. Choose the Save

button. The Save File As window will open. Select the drive, folder and enter a
filename for the configuration file.

10) Choose the save button and your file will be saved.
1 1) We can use this file for the configuration during future experiments.

GrassLab Recorder

1 2) After finish the configuration you are ready to recording data.
13) Open GrassLab window ,choose Start»Recorder from the menu bar. The

Open Configuration File window will open.
14) Select the drive, folder, and application configuration file to load. After

selecting file choose the Open button. The configurations stored in the file will
be loaded and GrassLab recorder will start.

1 5) Choose Edit»Preferences and select recording duration.
16) Choose M 15 tab form GrassLab Recorder and do amplifier settings.
1 7) Choose traces from GrassLab Recorder button go to filter option and do digital

filter settings.
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1 8) Choose exit button to close the trace properties window.
19) Choose File »Recording» Start. The file name window will open.
Select a drive, folder, and file name for the recording. The default location is

C:\Grasslab\Data. Then choose save. A folder will be created with the file name you
specify. The Grasslab recording file will be saved in this folder with the specified file
name. The recording will begin. To stop the recording, choose File»Recording»Stop.
The Start/Stop button can also be used to start and stop recording of a file. The Start/Stop
button is located in the top left corner of the window.

GrassLab Reviewer

After completing experiment we review our data and transfer it in different format
20) Open GrassLab window. Choose the Reviewer button or Start»Reviewer

from the menu bar. A file selection window will open.
21) Select the drive, folder, and file for review. By default, the following path will

be used: C:\Grasslab\Data
22) After selecting the file, choose the Open button. The file will be opened in the

GrassLab Reviewer window.
23) Choose File » Export»ASCII. Enter the desired file name into the text box

under ASCII File Name. You can select the range of data.
24) To include a channel in the exported file, select it from the Channel selection

drop down menu and click the Include button. To exclude it, click the Exclude
button. To exclude all channels, click the Exclude All button.

25) Click OK. The file will be created in the same directory as the original data.
26) To close GrassLab, choose File»Exit from the GrassLab Main Menu

window.
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Algorithms for Analysis

For Profile 1

clear all; clc; close all;
? = load('samir 10 august.txt'); % loading subject data
Fs = 200;
% Filter using IIR 5 point Butterworth (0.3-35 Hz);
? = 5; Wn = [0.3 35]/Fs;
[b,a] = butter(n,Wn);
pi = filtfilt(b,a,p);
Wn = 400;
Ws = 400/2;
NFFT=1024*Fs;
c=mat2cell(pl,[71800 108000 60200],[6]);
ss=c {2,1};
cl=mat2cell(ss,[36000 36000 36000], [6]);
ssl=cl {1,1}; % Profile 1
c2=mat2cell(ssl,[6000 6000 6000 6000 6000 6000],[6]);
ss2=c2{l,l};
c3=mat2cell(ss2,[600 600 600 600 600 600 600 600 600 600],[6]);
ss3=c3{l,l};
c4=mat2cell(ss3,[100 300 200],[6]);
ss4=c4{2,l};
yl=ss4;
c5=mat2cell(ss2,[600 600 600 600 600 600 600 600 600 600],[6]);
ss5=c5{2,l};
c6=mat2cell(ss5,[100 300 200],[6]);
ss6=c6{2,l};
y2=ss6;
c7=mat2cell(ss2,[600 600 600 600 600 600 600 600 600 600],[6]);
ss7=c7{3,l};
c8=mat2cell(ss7,[100 300 200],[6]);
ss8=c8{2,l};
y3=ss8;
c9=mat2cell(ss2,[600 600 600 600 600 600 600 600 600 600],[6]);
ss9=c9{4,l};

cl0=mat2cell(ss9,[100 300 200],[6]);
ssl0=cl0{2,l};
y4=ssl0;
cl I=mat2cell(ss2,[600 600 600 600 600 600 600 600 600 600],[6]);
ssll=cll{5,l};
cl2=mat2cell(ssl 1,[100 300 200],[6]);
ssl2=cl2{2,l};
y5=ssl2;
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cl3=mat2cell(ss2,[600 600 600 600 600 600 600 600 600 600],[6]);
ssl3=cl3{6,l};
cl4=mat2cell(ssl3,[100 300 200],[6]);
ssl4=cl4{2,l};
y6=ssl4;
cl5=mat2cell(ss2,[600 600 600 600 600 600 600 600 600 600],[6]);
ssl5=cl5{7,l};
cl6=mat2cell(ssl5,[100 300 200],[6]);
ssl6=cl6{2,l};
y7=ssl6;
cl7=mat2cell(ss2,[600 600 600 600 600 600 600 600 600 600],[6]);
ssl7=cl7{8,l};
cl8=mat2cell(ssl7,[100 300 200],[6]);
ssl8=cl8{2,l};
y8=ssl8;
cl9=mat2cell(ss2,[600 600 600 600 600 600 600 600 600 600],[6]);
ssl9=cl9{9,l};
c20=mat2cell(ssl9,[100 300 200],[6]);
ss20=c20{2,l};
y9=ss20;
c21=mat2cell(ss2,[600 600 600 600 600 600 600 600 600 600],[6]);
ss21=c21{10,l};
c22=mat2cell(ss21,[100 300 200],[6]);
ss22=c22{2,l};
yl0=ss22;
Y=[yl;y2;y3;y4;y5;y6;y7;y8;y9;yl0];
EEG = Y(:,4);
for k= 1 : Ws:(length(EEG)-Wn);

x = EEG(k:k+Wn-l);
[Pxx, Fxx] = pburg(x, 8,NFFT,Fs);
F = Fs/2*linspace(0,l,NFFT/2);
dF = max(F)/length(F);
Fl=floor(4/dF);
F2=fioor(7/dF);
F3=floor(12/dF);
F4 = floor(20/dF);
F5 = floor(30/dF);
alphaPower = sum(Pxx(F2:F3));
betaPower = sum(Pxx(F3:F4));
deltaPower = sum(Pxx(l :F1));
thetaPower = sum(Pxx(Fl :F2));
TotalPower = sum(Pxx(l:F4));
BrainPower = [deltaPower; thetaPower; alphaPower; betaPower;];
BrainPower = (BrainPower/TotalPower)*100;

end

76



For Profile 2

clear all; clc; close all;
? = load('samir 10 august.txt'); % loading subject data
Fs = 200;
% Filter using HR 5 point Butterworth (0.3-35 Hz);
n=5;Wn = [0.3 35]/Fs;
[b,a] = butter(n,Wn);
pi = filtfilt(b,a,p);
Wn = 400;
Ws = 400/2;
NFFT= 1024*Fs;
c=mat2cell(pl,[71800 108000 60200],[6]);
ss=c {2,1};
cl=mat2cell(ss,[36000 36000 36000],[6]);
ssl=cl {2,1}; % Profile 2
c2=mat2cell(ssl,[6000 6000 6000 6000 6000 6000],[6]);
ss2=c2{l,l};
c3=mat2cell(ss2,[600 600 600 600 600 600 600 600 600 600],[6]);
ss3=c3{l,l};
c4=mat2cell(ss3,[100 300 200],[6]);
ss4=c4{2,l};
yl=ss4;
c5=mat2cell(ss2,[600 600 600 600 600 600 600 600 600 600],[6]);
ss5=c5{2,l};
c6=mat2cell(ss5,[100 300 200],[6]);
ss6=c6{2,l};
y2=ss6;
c7=mat2cell(ss2,[600 600 600 600 600 600 600 600 600 600],[6]);
ss7=c7{3,l};
c8=mat2cell(ss7,[100 300 200],[6]);
ss8=c8{2,l};
y3=ss8;
c9=mat2cell(ss2,[600 600 600 600 600 600 600 600 600 600],[6]);
ss9=c9{4,l};

cl0=mat2cell(ss9,[100 300 200],[6]);
ssl0=cl0{2,l};
y4=ssl0;
cl I=mat2cell(ss2,[600 600 600 600 600 600 600 600 600 600],[6]);
ssll=cll{5,l};
cl2=mat2cell(ssll,[100 300 200],[6]);
ssl2=cl2{2,l};
y5=ssl2;
cl3=mat2cell(ss2,[600 600 600 600 600 600 600 600 600 600],[6]);
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ssl3=cl3{6,l};
cl4=mat2cell(ssl3,[100 300 200],[6]);
ssl4=cl4{2,l};
y6=ssl4;
cl5=mat2cell(ss2,[600 600 600 600 600 600 600 600 600 600], [6]);
ssl5=cl5{7,l};
cl6=mat2cell(ssl5,[100 300 200],[6]);
ssl6=cl6{2,l};
y7=ssl6;
cl7=mat2cell(ss2,[600 600 600 600 600 600 600 600 600 600], [6]);
ssl7=cl7{8,l};
cl8=mat2cell(ssl7,[100 300 200],[6]);
ssl8=cl8{2,l};
y8=ssl8;
cl9=mat2cell(ss2,[600 600 600 600 600 600 600 600 600 600], [6]);
ssl9=cl9{9,l};
c20=mat2cell(ssl9,[100 300 200],[6]);
ss20=c20{2,l};
y9=ss20;
c21=mat2cell(ss2,[600 600 600 600 600 600 600 600 600 600],[6]);
ss21=c21{10,l};
c22=mat2cell(ss21,[100 300 200],[6]);
ss22=c22{2,l};
yl0=ss22;
Y=[yl;y2;y3;y4;y5;y6;y7;y8;y9;yl0];
EEG = Y(:,4);
for k= 1 : Ws:(length(EEG)-Wn);

x = EEG(k:k+Wn-l);
[Pxx, Fxx] = pburg(x, 8,NFFT,Fs);
F = Fs/2*linspace(0,l,NFFT/2);
dF = max(F)/length(F);
Fl=floor(4/dF);
F2=floor(7/dF);
F3=floor(12/dF);
F4 = floor(20/dF);
F5 = floor(30/dF);
alphaPower = sum(Pxx(F2:F3));
betaPower = sum(Pxx(F3:F4));
deltaPower = sum(Pxx(l:Fl));
thetaPower = sum(Pxx(Fl :F2));
TotalPower = sum(Pxx(l :F4));
BrainPower = [deltaPower; thetaPower; alphaPower; betaPower;];
BrainPower = (BrainPower/TotalPower)*100;

end
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For Profile 3

clear all; clc; close all;
? = load('samir 10 august.txt'); % loading subject data
Fs = 200;
% Filter using HR 5 point Butterworth (0.3-35 Hz);
? = 5; Wn = [0.3 35]/Fs;
[b,a] = butter(n,Wn);
pl=filtfilt(b,a,p);
Wn = 400;
Ws = 400/2;
NFFT = 1024*Fs;
c=mat2cell(pl,[71800 108000 60200],[6]);
ss=c{2,l};
cl=mat2cell(ss,[36000 36000 36000], [6]);
ssl=cl {3,1}; % Profile 3
c2=mat2cell(ssl,[6000 6000 6000 6000 6000 6000],[6]);
ss2=c2{l,l};
c3=mat2cell(ss2,[600 600 600 600 600 600 600 600 600 600], [6]);
ss3=c3{l,l};
c4=mat2cell(ss3,[100 300 200]. [6]);
ss4=c4{2,l};
yl=ss4;
c5=mat2cell(ss2,[600 600 600 600 600 600 600 600 600 600],[6]);
ss5=c5{2,l};
c6=mat2cell(ss5,[100 300 200], [6]);
ss6=c6{2,l};
y2=ss6;
c7=mat2cell(ss2,[600 600 600 600 600 600 600 600 600 600],[6]);
ss7=c7{3,l};
c8=mat2cell(ss7,[100 300 200],[6]);
ss8=c8{2,l};
y3=ss8;
c9=mat2cell(ss2,[600 600 600 600 600 600 600 600 600 600],[6]);
ss9=c9{4,l};

cl0=mat2cell(ss9,[100 300 200],[6]);
ssl0=cl0{2,l};
y4=ssl0;
cl I=mat2cell(ss2,[600 600 600 600 600 600 600 600 600 600],[6]);
ssll=cll{5,l};
cl2=mat2cell(ssll,[100 300 200],[6]);
ssl2=cl2{2,l};
y5=ssl2;
cl3=mat2cell(ss2,[600 600 600 600 600 600 600 600 600 600],[6]);
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ssl3=cl3{6,l};
cl4=mat2cellssl3,[100 300 200],[6]);
ssl4=cl4{2,l};
y6=ssl4;
cl5=mat2cell(ss2,[600 600 600 600 600 600 600 600 600 600],[6]);
ssl5=cl5{7,l};
cl6=mat2cell(ssl5,[100 300 200],[6]);
ssl6=cl6{2,l};
y7=ssl6;
cl7=mat2cell(ss2,[600 600 600 600 600 600 600 600 600 600],[6]);
ssl7=cl7{8,l};
cl8=mat2cell(ssl7,[100 300 200],[6]);
ssl8=cl8{2,l};
y8=ssl8;
cl9=mat2cell(ss2,[600 600 600 600 600 600 600 600 600 600],[6]);
ssl9=cl9{9,l};
c20=mat2cell(ssl9,[100 300 200],[6]);
ss20=c20{2,l};
y9=ss20;
c21=mat2cell(ss2,[600 600 600 600 600 600 600 600 600 600],[6]);
ss21=c21{10,l};
c22=mat2cell(ss21,[100 300 200],[6]);
ss22=c22{2,l};
yl0=ss22;
Y=[yl;y2;y3;y4;y5;y6;y7;y8;y9;yl0];
EEG = Y(:,4);
for k= 1 : Ws:(length(EEG)-Wn);

x = EEG(k:k+Wn-l);
[Pxx, Fxx] = pburg(x, 8,NFFT5Fs);
F = Fs/2*linspace(0,l ,NFFT/2);
dF = max(F)/length(F);
Fl=floor(4/dF);
F2=floor(7/dF);
F3=floor(12/dF);
F4 = floor(20/dF);
F5 = floor(30/dF);
alphaPower = sum(Pxx(F2:F3));
betaPower = sum(Pxx(F3:F4));
deltaPower = sum(Pxx(l :F1));
thetaPower = sum(Pxx(Fl :F2));
TotalPower = sum(Pxx(l :F4));
BrainPower = [deltaPower; thetaPower; alphaPower; betaPower;];
BrainPower = (BrainPower/TotalPower)*100;

end
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